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Unit 1: Creating Custom Merge Documents

Objectives:

Upon completing this unit, you will be able to:

• Access the Marketing Tools package.
• Add a new document.
• Create document categories using “child records.”
• Insert images into a document.
• Add merge fields to a document.
• Format text in a document.

Using the Marketing Tools Package

Image 1.1: Marketing Tools
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Unit 1:  Creating Custom Merge Documents
Concept:

The Caterease Marketing Tools package is a powerful add-in to the basic Caterease 
program. It allows you to create any number of merge documents and envelopes and 
to generate labels in a variety of pre-formatted Avery styles.

In case you’re unfamiliar with the term, a merge document is a type of document that 
enables you to generate special fields throughout the text, and these fields will dynam-
ically pull in information from any Caterease event. A basic merge document typically 
looks like this:

Dear [So-and So],
You have [a certain party] in [a certain room] on [a certain date].

All of the information in brackets will dynamically merge in the appropriate data from 
specific events. Therefore, one document that you type one time will look completely 
unique for each separate event.

Accessing the Marketing Tools Package

See Image 1.1 1. Click the Setup sidebar group on the left-hand side of your Caterease screen.
2. Click the Marketing Tools button.

Note: As an option, you can also select Administration > Prints > Marketing
 Tools from the drop-down menus at the top of the screen.

Image 1.2: Adding a New Document
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Unit 1:  Creating Custom Merge Documents
Adding a New Merge Document

1. Access Marketing Tools via one of the options listed above.

2. Click the Add Record button , located on your main Caterease toolbar at the 
top of the screen.
Result: A confirmation message appears. 

3. Click Yes to confirm your choice.
Result: A new, blank field is added to your list, with your cursor ready to type a 
new title.

4. Type a name for your new document, and press your [Enter] key.
Result: Your new document name is saved.

5. Click into the main text block of the Marketing Tools form and type the body of 
your document as desired. 
Note: See the following sections for information on inserting merge fields, 
images, and tables into your merge document.

6. [Optional] Format your document's text using the Basic Text Editing option 
located on your main Caterease screen (see the following sections).

Adding a Document as a Child Record (Sub-Record)

Concept:

Often, if you have a large collection of merge documents, it helps to organize them 
into groups. For example, you can create a group heading called “Printed Documents” 
and add documents that are printed as sub-records of that group. Then you could per-
haps create another group called “E-mailed Documents” and create sub-records in that 
group as well.

Image 1.3: Adding a Child Record
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Unit 1:  Creating Custom Merge Documents
1. From Marketing Tools, click the Add Record button , located on your main 
Caterease toolbar at the top of the screen.
Result: A confirmation message appears.

2. Click Yes to confirm your choice.
Note: This adds a new blank document title, as described in Step 1 under Adding a 
New Document, above. In this section, however, we are going to use this new title 
as the title of the group or category of documents we want to create.

3. Type a name for your category or group of documents, and press your [Enter] 
key.
Result: Your new category name is saved.

4. Click the Add Child Record button , also located at the top of your screen.
Result: A confirmation message appears.

5. Click Yes to confirm your choice.
Result: A new document title is added as a sub-record of the title you added in 
Step 1, above.

6. Type a name for your new document, and press your [Enter] key.
Result: Your new document name is saved.

7. Click into the main text block of the Marketing Tools form and type the body of 
your document as desired. 
Note: See the following sections for information about inserting merge fields, 
images, and tables into your merge document.

8. [Optional] Format your document's text using the Basic Text Editing option 
located on your main Caterease screen (see the following sections). 

Inserting Images into a Document

Concept:

Images can make a merge document colorful and attractive. For example, if you do 
not have an official company letterhead that you use to print your Caterease docu-
ments on, you can insert your company logo at the top of each document you create.

Image 1.4: Inserting an Image
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Unit 1:  Creating Custom Merge Documents
1. Click in the document to place your cursor where you want the image to be 
inserted.

2. Click the Insert button , located at the top of the Marketing Tools form, and 
select Image. Alternatively, you may right-click anywhere in the document and 
select Insert Image. 
Result: A window opens, allowing you to browse to an image.

3. Click the down arrow next to File name and browse your way to your desired 
image.

4. Double-click the image to select it.
Note: As a default, the image is inserted as a “Character.” (See Changing the 
Attach Mode of an Image, below.) This means that it will move as other text 
moves, and you can use the Format toolbar to align it (left, center, right), and fur-
ther customize it.

5. Click Open.
Result: The selected image is placed in the document wherever your cursor is 
blinking.

6. Format your document’s text and image using the Basic Text Editing option at the 
top left-hand side of your Caterease screen. 

Changing the Attach Mode of an Image

Image 1.5: Changing Image Attach Mode
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See Image 1.5 Concept:

When you insert an image into a document, it is automatically inserted as if it were a 
character in the document. Therefore, it moves with all the other text as you make 
changes, and responds to the same formatting tools (left/center/right justification, 
etc.). As an option, you can change the way an image is attached, and thereby cause 
text to wrap around it on one side or the other (or both sides), or even place an image 
behind the document’s text (in the case of a watermark).

1. Right-click an image in your document.
Result: A pop-up menu appears.

2. Select Attach Mode.
3. Choose from the following options:

• As Character
This is the default mode, where the image acts as any other character in the 
document and moves and wraps with the text around it.

• Relative to Paragraph - Auto Wrap Left or Right
Attaches the image to a paragraph. Drag the image to any paragraph, and drag 
it left or right on the screen. If the image is closer to the right-hand side of the 
page, text will wrap to its left (and vice versa).

• Relative to Paragraph - Auto Wrap Left and Right
Attaches the image to a paragraph. Drag the image to any paragraph, and drag 
it left or right on the screen. Text will automatically wrap on both sides of the 
image.

• Relative to Page - No Wrapping
Attaches the image to the page. You can drag the image to any position you 
want. Text will not wrap.
Note: Use this mode with a faded image to create a watermark effect. (You'll 
want to choose the "Under Text" option, below.)

• Relative to Page - Wrap Left and Right
Attaches the image to the page. You can drag the image to any position you 
want, and text will automatically wrap on both sides as necessary.

• Under Text
Places the image behind text on the page as you drag it. Use this in conjunc-
tion with "Relative to Page - No Wrapping" (above) to create a watermark 
effect.

Adding Merge Fields to a Document

See Image 1.6 Concept:

Merge fields are what make a merge document unique. For example, instead of typing 
the name of a particular person to whom you want to address a document, you can use 
a merge field that will pull in that person’s name when the document is printed from a 
particular event. Instead of typing event-specific details, such as event date, room 
information, etc., you can insert merge fields to incorporate that information dynami-
cally. This way, the document you create looks completely unique each time you print 
it.
Note: The appendix at the back of this guidebook describes the available merge fields.
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Unit 1:  Creating Custom Merge Documents
1. Click the Insert Merge Fields button , located at the top right-hand side of 
the Marketing Tools form you are working on.
Result: The Fields Explorer window opens.
Note: If you plan to insert several merge fields, you may want to leave this win-
dow open and even drag it out of the way so you can see your print underneath.

2. Click the plus sign to the left of a particular category of fields, e.g., Event Fields, 
Financial Fields, etc., to expand the fields.
Result: The selected category opens to show all related fields.

Note: As an option, click the Full Expand button , located at the top of the 
Fields Explorer window, to expand all categories of merge fields at once.

3. Select a merge field, and insert in one of the following ways:
• Hold your left mouse button down on the field, drag it into any position on 

your document, envelope, or comments section, and release.
• Double-click the selected field to drop it in the current cursor position (where 

your cursor is currently blinking).
• Click the Select button to drop the field in the current cursor position.

Note: Comments and notes that have been typed into text blocks within your 
Event Manager can also be included as merge fields, by selecting Comments 
(Unformatted), Event Notes (Unformatted), Site Directions (Unformatted), 
etc. 

Image 1.6: Inserting Merge Fields
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Unit 1:  Creating Custom Merge Documents
Using Advanced Merge Field Options

In addition to standard merge fields, Caterease also allows you to insert special date 
fields that can automatically calculate appropriate due dates (two days BEFORE the 
event date, seven days AFTER the booked date, etc.), and which can be customized to 
show various day/month/year formats. Additionally, large blocks of text (event notes, 
sub-event comments, etc.), can be placed anywhere in a document, and can either 
maintain the formatting they have in your Event Manager or can be made to adopt the 
formatting of the merge document itself.

Using Formatted Date Fields (See Table 1.1)

Concept:

Formatted date fields allow you to have the merge document automatically calculate 
certain dates; for example, ten days from the CURRENT date or two days before the 
EVENT date, whenever you print the document. In addition, you can format these 
fields in a variety of day/month/year styles.

1. Click inside the document to place your cursor where you want the merge field to 
be inserted.

2. Click the Insert Merge Fields button , located at the top right-hand side of 
the Marketing Tools form you are working on.

3. Click the plus sign to the left of Event Fields (for Event Date Formatted or 
Booked Date Formatted) or Special Fields (for Current Date Formatted).

4. Select the desired merge field and insert it in one of the following ways:
• Double-click the selected merge field to drop it into the current cursor posi-

tion (where your cursor currently resides).
• Hold your left mouse button down on the field, drag it into any position on 

your document, envelope, or comments section, and release.
• Click the Select button to drop the merge field into the current cursor position.

5. Format the date field by editing the “mmmm,” “d,” “y,” and number within the 
brackets, using the options listed in the table below.
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Unit 1:  Creating Custom Merge Documents
Formatting Text (See Table 1.2)

1. Within a document in the Marketing Tools, highlight any text you wish to format 
by holding your left mouse button down and dragging over the text. 

2. Access the Basic Text Editing toolbar at the top of your Caterease screen.
3. In the Font window, choose a different font, font style, size, color, or effect for 

your text.

Table 1.1: Formatted Date Fields

Symbol Description

d Displays the day as a number without a leading zero (1-31).

dd Displays the day as a number with a leading zero (01-31).

ddd Displays the date as an abbreviation (Sun-Sat).

dddd Displays the day as a full name (Sunday-Saturday).

m Displays the month as a number without a leading zero (1-
12).

mm Displays the month as a number with a leading zero (01-12).

mmm Displays the month as an abbreviation (Jan-Dec).

mmmm Displays the month as a full name (January-December).

y Displays the year as a four-digit number.

+ Adds days to the applicable merge date.

- Subtracts days from the applicable merge date.

Table 1.2: Format Toolbar Buttons

Button Description

Font Style: Click the down arrow and choose 
another font for the selected text.

Font Size: Click the down arrow and choose 
another size for the selected text.

Font Color: Click the down arrow and choose 
another color for the selected text.

Bold: Click this button to make the selected text 
bold.

Italic: Click this button to make the selected text 
italic.

Underline: Click this button to underline the 
selected text.
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Remember This:

In this unit, you have learned a few very important concepts about creating a merge 
document. Here are some things you might want to jot down in the Table of Things I 
Want to Remember on the last page of this book:

• The Marketing Tools Package can be accessed in a variety of easy ways 
(Page 1.2).

• Documents can be separated into groups or categories for better organization 
(Page 1.3).

• You can insert images anywhere throughout the body of a document (Page 1.4).

• You can insert merge fields throughout your document to dynamically merge in 
information from any customer or event (Page 1.6).

Align Left: Click this button to align the selected text 
with the left-hand side of the window.

Align Center: Click this button to center the 
selected text in the window.

Align Right: Click this button to align the selected 
text with the right-hand side of the window.

Bullet Wizard: Click this button to choose a custom 
character to use as a bullet.

Increase Indent: Click this button to increase the 
paragraph indent of the selected text.

Decrease Indent: Click this button to decrease the 
paragraph indent of the selected text.

Table 1.2: Format Toolbar Buttons (Continued)

Button Description
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Unit 2: Advanced Features for Custom 
Merge Documents

Objectives:

Upon completing this unit, you will be able to:

• Create headers and footers.
• Insert a table into a merge document.
• Color row, column, or text background.
• Insert a hyperlink.
• Insert a page break.
• Add or delete columns or rows to a table.
• Adjust the page margins of a document.
• Create a custom envelope.

Creating Headers and Footers

Concept:

You can create custom headers and footers for your merge documents, including rich-
text merge fields, images, and more. These headers and footers can also be designated 

Image 2.1: Creating Headers and Footers
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to appear on specific pages, so you can create multiple headers and footers for a par-
ticular document.

1. From Marketing Tools, click the title of the document you want to add headers or 
footers to. 

2. Click the Tools button, located in the Extended Text Editing group on the Home 
ribbon tab at the top of the screen.

3. Click Headers & Footers
Result: The Manage Header & Footer window opens.

4. Choose Add Header or Add Footer.
5. From the drop-down list which displays, select which pages should include the 

new header/footer.
Result: The header/footer is added to the document, and your cursor is placed in 
it.
Note: If adding a header/footer that will not appear on the current document page 
(i.e., “Not on first page,” “Even pages,” etc.), your cursor will be moved from the 
current page to the header/footer until you finish editing it.

6. Type the header/footer text and then format as desired.
Note: Insert images, merge fields, etc., into headers and footers as desired, using 
the steps described in the previous unit.

7. [Optional] Add additional headers or footers as desired by repeating steps 4-6. 
Note: Switch from one header/footer to another by clicking on it in the Manage 
Header & Footer window. Move to the body of the document by clicking Go To 
Body.

8. [Optional] Click the Options button and choose Save Text to save this custom 
header/footer for use in another merge document.
Note: To add a previously saved header/footer into a document, add a header/
footer as described above and then click Options > Load Text. 

9. When finishing editing headers/footers, click Close. 

Inserting a Table into a Document

Image 2.2: Inserting a Table
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Concept:

Tables are a great way to organize a document, and in many cases can be better than 
tabs for arranging details into straight columns. For example, imagine you have used 
tabs and merge fields to create a document similar to this:

Client: [Client.Name] EventDate:[Event.Date.Long]
Theme: [Event.Theme] Start Time: [Start.Time]

It looks good now, before the details merge in. However, if the client name (or some 
other field) is a bit longer than you expect, the document might end up looking like 
this when the data merges:

Client: Collier County Sheriff’s Department   Event Date: Sunday, July 7, 2013
Theme: Awards Celebration    Start Time: 7:00PM

Notice that the client name that merged into this document took up more space than 
the tabbing allowed, so the “Event Date” information was forced further over to the 
right. If, however, this information had been arranged in a table, text in both columns 
would have wrapped appropriately, and details would have lined up properly. Further-
more, if we had chosen a table without borders, we would sacrifice absolutely nothing 
by way of aesthetic appeal.

Creating a Table 

1. Click in the document where you would like the table to be inserted.
2. Click the Create Table button, located under Tables, on the right-hand side of the 

Marketing Tools window, in the Extended Text Editing section.
Result: The Insert Table window opens.

3. Create a table by setting the following options:
• Number of Columns

Set the number of columns you want in your table.
• Number of Rows

Set the number of rows you want in your table.
• Alignment

Select whether you want the table to appear on the left-hand side of the page, 
in the center, or on the right.
Note: If the width of your table is 100% (see Width, below), then the table will 
take up the entire width of the page.

• Border
Choose whether or not you want borders around the cells of your table.
Note: Borders can be removed after the table has been inserted, if necessary.

• Width
Set the width for your table as a percentage of the page you are placing it on.

4. When finished, click OK.
Result: The table is inserted at the current position of your mouse pointer.
Note: As an alternative, you can click the Create Table Tool button, move your 
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mouse to indicate the number of columns and rows you want in your table, then 
click again to create the table.

Modifying a Table (See Table 2.1)

Concept:

Once you have inserted a table into a document, you can easily make changes such as 
adding or deleting rows or columns or splitting or merging table cells.

1. Click your cursor in the cell of the table at the point you want to make a modifica-
tion (or highlight multiple cells).

2. Select from the options described below, which are available on the toolbar at the 
right of the Marketing Tools form.

Table 2.1: Table Modifications

Selection Description

Delete Table: This button, found under the Tables but-
ton in the Extended Text Editing group, will delete the 
entire table. 

Split Cell: Splits the cell or cells you have highlighted in 
half (i.e., splitting each individual cell into two).

Combine Cells: Combines the currently highlighted 
cells into one cell. Note: To use, first highlight two or 
more cells in the table.

Insert Row: Inserts a row below the current cursor posi-
tion.

Delete Row: Deletes the row where the cursor currently 
resides.

Insert Column: Inserts a column to the right of the cur-
rent cursor position.

Delete Column: Deletes the column where the cursor 
currently resides.

Left Borders: Activates borders on the left side of the 
currently highlighted cell(s).

Right Borders: Activates borders on the right side of 
the currently highlighted cell(s).

Top Borders: Activates borders across the top of the 
currently highlighted cell(s).

Bottom Borders: Activates borders across the bottom 
of the currently highlighted cell(s).
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Deleting a Table

1. Click anywhere in a table to place your cursor in that table.
2. Hold your left mouse button down and drag over the entire table to select it.
3. Press the [Delete] key on your keyboard.

Result: The highlighted table is deleted, without confirmation.You may also delete 
a table by clicking the Tables button and clicking Delete. 
Note: If you accidentally delete a table, you can click the Cancel Changes button  

 at the top of your Caterease screen to cancel all changes made to the docu-
ment since your last Save. 

Coloring Row, Column, or Text Background

Concept:

You can customize the coloring and textures of all row, column, or text background. 
Doing so will give your Marketing Tools document a unique formatted style that may 
only be achieved when you use Caterease software. 

Adding Color to a Table’s Row, Column, or Cell

1. Click inside the table’s cell or highlight an entire row or column.

2. Click the Shading button  , located in the Extended Text Editing group on 
the Home ribbon tab at the top of the screen.

3. Choose a background color or optionally click Custom to define a custom color.
Result: The background color of the selected cell, row, or column, will be 
changed.
Note: The background color of any text in these cells will remain white, and must 
be changed separately, as described below.

Switch Borders On: Activates all borders in the cur-
rently highlighted cell(s).

Switch Borders Off: Turns off all borders in the cur-
rently highlighted cell(s).

Inner Borders: Activates inside borders (vertical and/
or horizontal) of the currently highlighted cell(s).

Outer Borders: Activates borders on the outside edges 
of the currently highlighted cell(s).

Table 2.1: Table Modifications

Selection Description
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Adding Background Color to Text

1. Highlight the desired text in a merge document.

2. Click the Text Highlight Color button , located in the Extended Text Edit-
ing group on the Home ribbon tab at the top of the screen.

3. Choose a background color or optionally click Custom to define a custom color.
Result: The background color of the selected text will be changed.

Inserting Merge Formulas

See Image 2.3 Concept:

Perhaps there is some detail you want to include in a merge document, but that detail 
will vary depending on a particular condition. For example, maybe you would like to 
include some payment terms on the print, and those terms will vary depending upon 
how many days out the event is. Or perhaps you want to include a brief biographical 
paragraph about the event’s sales rep, which will obviously need to change depending 
on which rep is responsible for the party your print is associated with. The incredible 
Merge Formula feature lets you create unlimited text, including merge fields that will 
dynamically change based on the conditions you establish.

Image 2.3: Creating a Merge Formula
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Setting up the Merge Formula Default

See Image 2.3 1. Click the Tools button at the top right of the Marketing Tools window and choose 
Merge Formulas Setup.
Result: The Marketing Tools Merge Formula Setup window opens.

2. Along the Merge Formulas (left-hand) pane of the window, click the Add For-

mula button .
Result: The Edit Formula window opens.

3. Type a name for the formula into the Name field.

4. Click the Edit Default Value button .
Result: The Formula Default Value text block opens.

5. Enter a default value for this formula, formatting text and inserting merge fields as 
described in the previous unit.
Note: This is the default text that will appear whenever you insert this formula, 
unless certain conditions you set (see below) apply.

Establishing Conditions for a Formula

See Image 2.4 1. Click the Tools button at the top right of the Marketing Tools window and choose 
Merge Formulas Setup.
Result: The Marketing Tools Merge Formula Setup window opens.

2. In the Merge Formulas (left-hand) pane, select a formula to establish conditions 
for.

3. Along the Optional Evaluations (right-hand) pane, click the Add Evaluation but-

ton .
Result: The Edit Evaluation window opens.

4. In the first drop-down on the Edit Evaluation window, set a condition for the 
merge formula.
Note: For example, you can set a condition that different text should appear if 
printing for an event that has a certain theme, a date that falls within a certain 
date range, a certain financial total, or even a particular type of client.

5. Use the two drop-down lists to finish the condition.
For example, if you chose Event-Theme from the first drop-down list, you might 
choose Equals and then select a particular theme in the second drop-down. 

6. Click the View/Edit Evaluation Results button  .
Result: The Formula Results Value text block opens.

7. Enter a default value for this formula, formatting text and inserting merge fields as 
described in the previous unit.

8. Click the X at the top right-hand corner of the text block to close the window, and 
click OK to close the Edit Evaluation window. 

9. [Optional] Drag this new condition up or down in the list on the Optional Evalua-
tions (right-hand) pane of the window to establish a priority of conditions.
Note: Evaluations will be performed in the order in which they are listed. For 
example, if the first evaluation looks for “Theme Equal to Meeting” on events 
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where this condition is true, the formula will stop evaluating and will print the text 
for that condition.

10. Repeat steps 3-9 to add more conditions to the list as desired. 
11. When finished, click the X at the top right-hand side of the Merge Formulas Setup 

window to close it.

Inserting Merge Formulas into a Document

1. Click in the document to place your cursor where you want the merge formula to 
be inserted.

2. Click the Insert Merge Formulas button , located at the top right of the Mar-
keting Tools window.

3. Select a merge formula and insert it in one of the following ways:
• Double-click the selected merge formula to drop it into the current cursor 

position (where your cursor is currently blinking).
• Hold your left mouse button down on the formula name, drag it into any posi-

tion on your document, envelope, or comments section, and release.
• Click the Select button to drop the merge formula into the current cursor posi-

tion.

Image 2.4: Establishing Conditions for Merge Formulas
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Inserting a Hyperlink

See Image 2.5 Concept:

Often, especially in the case of e-mail letter templates, you might want to insert hyper-
links into the body of a merge document. Of course, you can simply type the hyperlink 
and the program will automatically recognize the format of a web or e-mail address. 
Or, you can use custom text as a hyperlink in the following way:

1. Click in your document where you would like the hyperlink to appear.

2. Click the Insert button , located in the Home ribbon tab at the top of your 
screen, in Extended Text Editing. 

3. Choose Hyperlink.
Note: Alternatively, you may right-click anywhere in the document and select 
Insert > Hyperlink. 
Result: The Insert Hyperlink pop-up window opens.

4. In the first field of the pop-up window, enter the web address (URL) for the hyper-
link.
Note: If you previously copied the address from your web browser, that address 
will default for you.

5. In the second field, enter the text that will serve as the hyperlink in the document, 
or select the Image option to select an image for use as the hyperlink.

6. When finished, click OK.
Note: If creating a text hyperlink, your custom hyperlink will reside in the docu-
ment. If using an image as a hyperlink, a browser window will open, where you 
can select the image to be used (and then click Open). 

Inserting a Page Break

Concept:

Perhaps you want certain information on a custom print to appear on a separate page.  
For example, maybe you would like your appetizer items to appear on a separate page 

Image 2.5: Inserting a Hyperlink
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from your entrees, or perhaps you want a special page at the end of a print for terms 
and conditions. In these cases, you can simply insert a page break in the custom print.

Inserting the Page Break

1. Click in your document where you would like the page break to appear.

2. Click the Insert button , located in the Home ribbon tab at the top of your 
screen, in Extended Text Editing. 

3. Choose Page Break.
Note: Alternatively, you may right-click anywhere in the document and select 
Insert > Page Break. 
Result: The document separates, and all information below your insertion point 
appears on the next page.

Adjusting Page Margins and Other Setup Options

See Image 2.6 Concept:

You can change the paper size of a document, perhaps choosing legal-sized paper 
rather than the default letter-sized paper. You can also adjust the margins of your doc-
ument, and switch between Landscape and Portrait orientation.

Accessing the Page Layout Form

1. Click the Tools button at the top of the Marketing Tools window, under Extended 
Text Editing.

2. Choose Page Setup.
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Choosing a Paper Size

1. Click the down arrow under Paper Size on the Page Layout form.
2. Select the desired paper size (ex: “Legal,” “Envelope,” etc.).
3. When finished, click OK.

Adjusting the Page Margins in a Document

1. Use the up or down arrows next to the Top, Bottom, Left and Right field in the Page 
Layout form to adjust those page margins accordingly (or simply type into the 
fields).

2. When finished, click OK.

Switching between Portrait and Landscape Orientation

1. In the Orientation section of the Page Layout form, click the radio button next to 
Portrait or Landscape to select a style.

2. When finished, click OK.

Image 2.6: Adjusting the Page Margins
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Setting a New Paper Color

Concept:

Documents created in Marketing Tools can have any paper color, to serve as the 
default background color for all pages of the document, in prints and documents that 
are exported to PDF.

Tip: If you insert an 
image into your doc-
ument, any trans-
parent color will 
appear as white; 
you will therefore 
need to create an 
image with the 
appropriate back-
ground color that 
matches your docu-
ments’ paper color.

1. In the left pane of the Marketing Tools window, select the title of the document 
you want to change the color of.

2. Click the Tools button in the Home ribbon tab at the top of the screen and place 
your cursor over Paper Color.
Result: A popup color palette opens.

3. Click on the desired color within the color palette or click the Custom button to 
select a custom color. 
Note: Click the Clear button at the top of the popup window if you would like to 
clear your color selection.

Creating a Custom Merge Envelope

See Image 2.7 Concept:

Merge envelopes offer the same merge fields documents do, allowing you to create a 
custom envelope that will dynamically pull name and address information from any 
event or customer in your Caterease program.

Image 2.7: Creating a Custom Merge Envelope
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1. With your Marketing Tools window open, click the Add Record button , 
located on your main Caterease toolbar at the top of the screen.
Result: A confirmation prompt appears.

2. Click Yes to confirm your choice.
Result: A new blank document is added to your list, with your cursor ready to type 
a new title.

3. Type a name for your new envelope and press your [Enter] key.
Result: Your new envelope name is saved.

4. Click the Tools button at the top of the Marketing Tools window.
5. Choose Page Setup.
6. Click the down arrow under Paper Size on the Page Layout form.
7. Select the desired envelope size (ex: “Envelope #10,” “Envelope Monarch,” etc.).
8. [Optional] Change the margins of your envelope by typing in the fields listed 

under Margins, or use the up-and-down arrow keys to adjust.
9. Click the radio button labeled Landscape under Orientation.

Result: The envelope orientation flips to “Landscape,” or sideways.
10. When finished, click OK.
11. Click in the main text block of the Marketing Tools form and type as desired to 

create your new envelope.
Note: See previous unit for information on inserting merge fields into your enve-
lope.

12. [Optional] Format your envelope’s text using the Format toolbar at the top of 
your Caterease screen (see previous unit for more information).

Remember This:

In this unit, you have learned a few very important concepts about formatting a merge 
document or envelope. Here are some things you might want to jot down in the Table 
of Things I Want to Remember on the last page of this book:

• You can insert a table into a document for cleaner organization of information 
(Page 2.2).

• You can edit a table in a document — adding or removing columns or rows, etc. 
(Page 2.4).

• You can change the page setup of a document or envelope (Page 2.10).

• You can create custom merge envelopes to go along with your documents 
(Page 2.12).
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Merge Documents
Unit 3: Creating Advanced Event Prints

Objectives:

Upon completing this unit, you will be able to:

• Insert dynamic merge tables into a document to include such details as menu items, staffing, payments, 
deposits, etc.

• Modify a merge table.
• List merge table options within a document.
• Use nested tables to place details in the print.

Inserting a Merge Table into a Document

Image 3.1: Inserting a Merge Table
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Concept:

Merge tables give you the powerful opportunity to insert specific blocks of detail into 
a merge document- things that individual merge fields could not possibly cover, such 
as a list of menu items, or payments, or staff, or details of multiple sub-events, etc.

Inserting a Merge Table (See Image 3.1)

1. Click in the document where you would like the merge table to be inserted.

2. Click the Insert Merge Table button , located at the top right of the Market-
ing Tools window.
Result: A list of merge table options appears.

3. Select a merge table from the following options:
• Food/Service Items

Insert all menu items for the event, or choose to insert groups of menu items 
based on item Type, Category, Prep Area, or Hidden Status.

• Proposal Items
Insert all menu items selected for a proposal in Prospect Manager or option-
ally separate them based on item Type, Category, Prep Area, or Hidden Status. 

• Menu Items
Insert all menu items listed in your default menus in Menu Manager, or 
optionally separate them based on the menu they are in, or item Type, Cate-
gory, or Prep Area.

• Payments Made
Insert all payments made for the event, or choose to insert only payments of a 
particular pay method.

• Deposits Due
Insert all future deposits due for this event, or choose to insert only those 
deposits that have been paid or that remain unpaid.

• Event Times
Insert all Event times and timeline items for the event, or separate them based 
on Category.

• Scheduled Items
Insert all Scheduled Items for the event, or separate them based on Category 
or Type.

• Shifts
Insert all shifts scheduled for an event, or choose to insert groups of shifts 
based on Position or Shift Category.

• Staffing
Insert all employees scheduled to work an event, or choose to insert groups of 
staff based on Position, Staff Category, or whether they have confirmed they 
will work the event.

• Sub-Events
Insert details from all sub-events, including times and venue details - or 
choose to insert groups of sub-events based on sub-event Description or Type.

• Financial Summaries
Insert summary totals of groups of menu items based on item Type or Cate-
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gory, or general event financial totals such as the event Subtotal, Tax, Service 
Charge, Gratuity, Total, Cost, Profit, etc.

4. Select the specific details to be included in the merge table by clicking check-
boxes under the Select Fields section (left-hand side of the merge table window).
Note: You can drag and drop fields up and down in this Select Fields panel to 
reposition them in the merge table.

Establishing Display Options (See Image 3.2)

1. In the Display Options section of the window (top right-hand pane), choose from 
among the following options:

• Show Header
Shows a header row across the top of the table, labeling each column you 
have chosen to include (Description, Price, Qty, etc.).
Note: Optionally apply a background color to the header row using the color 
pallet to the right.

• Insert at the Bottom of Page
Inserts the table at the bottom-most line of your document, regardless of 
where your cursor currently resides.
Note: This may not necessarily be the bottom of the page; it’s the lowest car-
riage-return spot.

• Show Borders
Choose to show borders around each cell of the merge table (between each 
row and column).

Image 3.2: Establishing Merge Table Settings 
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• Show Filter Comment
Displays a comment below the merge table, describing the specific filter you 
apply to this table (see below).
Note: This comment will not print on the final document; it is visible in 
Design Mode only. You can also review the filter of an existing table by right-
clicking within the table and choosing Display Filter.

• Suppress Table When Empty
Suppresses the table from the printed document when it is empty, meaning no 
empty table or blank space will appear when there are no items to merge.

• Odd/Even Data Rows
Inserts a table which allows you to have a different look for each row. For 
example, on the first row you might want to have a picture on the left-hand 
side of the page and a description on the right-hand side; on the second row 
you might want to have the picture on the right-hand side of the page and the 
description on the left-hand side.

• Group by Sub-Event (Food/Service, Items, Shifts, and Staffing only)
When printed for an event with multiple sub-events, items in this table will be 
separated based on the sub-event they belong to.

Establishing Filter Options (See Image 3.2)

1. In the Filter Options section of the window (bottom right-hand pane), set the 
appropriate filters based on the type of merge table you are inserting. 
Note: You can add multiple merge tables in a document to separate items based 
on type, category, or a variety of other defaults.

2. When finished, click OK.

 
Modifying a Merge Table

Concept:

Once you have inserted a merge table into a document, you can make changes to it, 
such as adding or deleting rows or columns, or splitting or merging table cells, using 
the tools discussed in the previous unit. Furthermore, you can make additional 
changes specific to that particular type of merge table - adding fields or even editing 
the table’s filter - without having to re-create the entire table.
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Table 3.1: Filter Options

Filter Applicable Tables Description

Exclude Items
Without Quantities

Food/Service Items
Proposal Items

When printed from an event, the merge table will 
not include any menu items that lack quantities.

Menu Menu Items Select the title of the specific menu (or menus) to 
include on items from that menu in the table.

Type Food/Service Items
Proposal Items
Menu Items
Scheduled Items
Sub-Events

Choose to include items of a specific Type or 
Types based on a custom list you can create.

Category Food/Service Items
Proposal Items
Menu Items
Event Timeline
Scheduled Items
Shifts
Staffing

Choose to include items of a specific Category or 
Categoriesbased on a custom list you can create.

Prep Area Food/Service Items
Proposal Items
Menu Items

Choose to include items of a specific Prep Area or 
Areas based on a custom list you can create.

Hidden Status Food/Service Items
Proposal Items

Choose whether or not to include menu items des-
ignated to be “hidden” on prints. (Not in Menu 
Items table.)

Add Summary Row Food/Service Items
Proposal Items

Includes a row at the bottom of the merge table 
that totals the items in this one table (based on the 
filters you’ve established above). (Not in Menu 
Items table.)

Payment Method Payments Choose to include payments of a specific Payment 
Method or Methods based on a custom list you 
can create.

Paid Deposits Due Choose whether or not to include only deposits 
that have been paid, or only those outstanding, or 
both.

Position Shifts
Staffing

Choose to include shift or employee details for a 
specific Position (Waiter/Waitress, Bartender) or 
Positions based on a custom list you can create.

Confirmed Staffing Choose whether or not to include only employees 
who have confirmed that they will work a sched-
uled shift, or only those who haven’t, or both.

Description Sub-Events Choose to include sub-events of a specific 
Description or Descriptions based on a custom list 
you can create.
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Inserting Additional Fields

1. Click inside the merge table where you want a new field to appear.
Note: You can add new columns or rows for new fields as discussed in the previ-
ous unit.

2. Click your right mouse button.
3. Choose Merge Tables > Available Merge Fields.

Result: A list appears of available fields for the specific merge table you are 
working with.

4. Select a field from the list.

Displaying the Table Filter

1. Click in a specific merge table.
2. Click your right mouse button.
3. Choose Merge Tables > Display Filter.

Result: A pop-up message appears, identifying the filter of that particular table.
4. Click OK to close the pop-up message.

Image 3.3: Modifying Merge Tables
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Editing the Table Filter

1. Click into a specific merge table.
2. Click your right mouse button.
3. Choose Merge Tables > Edit Filter.

Result: A pop-up window appears, allowing you to edit the existing filter for the 
table.

4. Edit the filter as desired and click OK.

Nesting Merge Tables

See Image 3.4 Concept:

You can control the layout of a particular merge document using tables within tables, 
or “nested” tables. For example, imagine you want to design a contract that shows 
food items on the left side of the print and beverage items on the right. You can 
accomplish this by creating a standard, two-column table to split the page in half, and 
then inserting one merge table (for food items) in the left column and a second merge 
table (for beverage items) in the right column.

Creating the Original Table

1. Click the Create Table button , located under Tables, in the Extended Text 
Editing section of the Marketing Tools screen.

2. Choose the desired number of columns and rows for the table.
Note: This table is establishing the layout of your print. For example, if you want 
to separate menu items into two columns on the left and right side of the print, you 
would want to create two columns. Likewise, if you perhaps want headings above 
each group of items - perhaps saying “Food” on the left and “Beverages” on the 
right, you might want to create two rows (one for the headings, one for the merge 
tables of items themselves).

3. Set other options, such as whether or not to show borders in the table, as described 
previously.
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Inserting “Nested” Tables (See Image 3.4)

1. Click into the column or row of your original table where you would like to place 
your nested merge table.

2. Click the Insert Merge Table button .
3. Select the specific type of merge table you want to insert.
4. Click Yes at the prompt to confirm you want to create a nested merge table.
5. Format the merge table options as described earlier in this unit.

Result: Your custom merge table is inserted specifically in the row or column you 
have chosen - e.g., only on the left half of the page, etc.
Note: Be sure the merge table option Insert at the Bottom of the Page is 
unchecked to properly nest the table. 

Remember This:

In this unit, you have learned a few very important concepts about formatting a merge 
document or envelope. Here are some things you might want to jot down in the Table 
of Things I Want to Remember on the last page of this book:

• You can insert a dynamic merge table into a document to list an entire group of 
details, such as all menu items, payments, staffing, etc., for an event (Page 3.1).

Image 3.4: Nesting Merge Tables
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• You can modify existing merge tables - adding new merge fields or editing existing 
filters - without having to delete the merge table and recreate it (Page 3.4).

• You can “nest” merge tables within other tables, making a custom-designed lay-
out for your merge document (Page 3.7).
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Unit 4: Printing and Emailing Merge Documents

Objectives:

Upon completing this unit, you will be able to:

• Print a merge document for an individual event.
• Make a one-time only change to a document prior to printing.
• E-mail a merge document.
• Use a merge document as the body of an outgoing e-mail message.
• Print documents for a batch of events at one time.
• Print a merge document from Account Manager.

Printing a Document for an Event

See Image 4.1 Concept:

Once you have created your merge documents in your Marketing Tools package, you 
can quickly print them for a particular event from your Event Manager. Like your 
other event prints, these merge documents will merge in the specific details of the 
event you are on when you print them. 

1. Open your Event Manager on the specific event from which you want to print a 
documents

2. Click the Merge Documents button , located at the bottom of your Caterease 
screen.
Result: The Merge Documents window opens, listing all custom documents you 
have created in your program.

3. Select the title of the document you want to print.
4. Click the Print button at the top right of the Merge Documents window.

Result: A Print Preview of your chosen document opens.
5. Click the Print button at the top of the Print Preview screen to send this document 

to your printer.
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 Making a One-Time Modification to a Document

See Image 4.2 Concept:

Sometimes you might need to make a one-time change to a document on-the-fly as 
you print it, changing text, removing text, reformatting text or even adding new text. 
These changes will not affect your original document — they are simply for this one 
printing only.

Image 4.1: Printing a Merge Document
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1. Open your Event Manager on the specific event from which you want to print a 
document.

2. Click the Merge Documents button  at the bottom of your Caterease screen.
Result: The Merge Documents window opens.

3. Select the title of the document you want to print.
4. Click the Modify button at the top right of the Merge Documents window.

Result: Your document merges in information from the current event, and is dis-
played in an editor window.

5. Click anywhere in the editor window and type or edit as desired.
6. When finished, click the Prints button at the top left of the window.

Result: Your document, with its modifications, is displayed in a Print Preview 
screen.

7. Click the Print button at the top of the Print Preview screen to send this document 
to your printer.

Using the Floating Print Selection Tool 

Concept:

See Image 4.3 The floating print selection tool gives you the flexibility to choose your preferred print 
or prints (yes, even multiple prints) and have Caterease remember your selection each 
time you generate a print. You can leave this tool open as you navigate through events 
in the program, allowing you to generate one or several prints for one event after 
another, with just one mouse click!

Image 4.2: Modifying a Merge Document
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1. Open your Event Manager on the specific event from which you want to print a 
document.

2. Click the top half of the Prints button, located on the Home ribbon tab at the top 
of your Caterease screen.
Result: The Select Desired Prints window opens. 

3. Click the Prints tab on the left-hand side of the window. 
Note: All prints created in your Marketing Tools package are stored on the Prints 
tab.

4. Click the title of the print you want to print.
5. [Optional] Click the Multiple button at the top of the window and move titles to 

the right-hand pane of the tool (using the black right-arrow) to generate multiple 
prints at once.
Note: As an alternative, you can double-click print titles with the Multiple Prints 
pane open to select those prints for multiple printing. Also note, you can choose to 
enter quantities for each print.

6. Click the Print button at the bottom of the window to generate the print(s). 
Note: Alternatively, you can double-click the title of a print to generate it.

7. [Optional] For maximum flexibility, leave this floating tool open, with your 
favorite prints selected, as you move from event to event. 

Image 4.3: Floating Print Selection Tool
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Emailing a Merge Document

See Image 4.4 Concept:

If your preferred method of communication is e-mail, Caterease lets you e-mail one of 
your custom merge documents with just a mouse click. As with printing, all event 
details merge in dynamically. It will look as if you typed a custom merge document 
specifically for that customer!

1. Open your Event Manager on the specific event from which you want to print a 
document.

2. Click the Merge Documents button  at the bottom of your Caterease screen.
3. Select the title of the document you want to e-mail.
4. Click the Email button at the top right of the Merge Documents window.

Result: Your document merges in information from the current event, and is dis-
played in an e-mail window.

5. Type an e-mail address in the To ... field, or click the Address Book button at the 
top of the e-mail window to access your Caterease address book.

6. Type a subject for your e-mail in the Subject ... field, or click the down arrow to 
the right of the field to choose a subject from your customizable quick-pick list.

7. [Optional] Click the Attach button at the top of your e-mail window to attach a 
general computer file or a Caterease print or prints in.PDF or other format.

Image 4.4: Emailing a Merge Document
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8. When finished, click Send.
Result: The e-mail is sent, using the e-mail settings established in the program 
(Administration ribbon tab > Settings > Email Settings), and a message 
appears, offering to close the window.
Note: Before closing the e-mail window, you may want to store a history note and 
copy of the sent e-mail in Contact Manager. 

Using a Merge Document as the Body of an E-mail

 Concept:

E-mailing contracts and other event prints is most likely common practice for your 
business, and doubtlessly the e-mail letters to which those prints are attached are 
pretty standard fare:

Dear [Name],

Attached, please find the contract for your [Event Theme] to be held with us 
on [Event Date]. Please review the details and return to me at your earliest 
convenience.

Sincerely,
[Your Name]

Of course, this is a classic example of a merge letter. Thus, Caterease lets you embed a 
merge document as the body of your outgoing e-mail whenever you send a print to a 
customer (or to anyone).

1. Access the e-mail window from a Print Preview screen, as described above.
2. Click the Use Merge Document button from the menu at the top of the window.

Result: The Select Document window opens.
3. Double-click the merge document you want to use as the body of your e-mail.
4. Click OK.

Result: The document you selected is embedded as the body of the e-mail, and all 
merge fields are dynamically merged in.
Note: If content already existed in the body of the e-mail (including default signa-
ture), you will be asked if you want to replace it. 

Copying Sent E-mails into Contact Manager

1. Click the Contact History ribbon tab at the top of the e-mail window.
2. [Optional] Edit the Comment on the Contact History ribbon tab as desired.

Note: This is the content of the history note that will be added to your Contact 
Manager. It defaults to the words “Sent Email” and then the subject of the current 
email.

3. Click the Save button, located at the top left-hand side of the Contact History tab. 
Result: An information window displays, indicating that a contact history note 
has been recorded for this customer, automatically stamped with the current date 
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and time.
Note: You can set this option (and the Save Email Content option) to occur auto-
matically by clicking the Auto Save in Contact Manager button and selecting 

your option(s). Remember to click the Save Window Settings button  to retain 
this window setting.

4. Click OK to close the information window. 

5. [Optional] It is not necessary to click the Save Email Content button , 

located next to the Auto Save in Contact Manager button  and selecting 
your options; this option is generally set to occur automatically as a default. (See 
note in Step 3, above.)

6. Click OK to close the information window.

Generating E-mails from the Event Manager Toolbar

1. Open the event in Event Manager for which you want to e-mail the print.

2. Click the E-mail button , located on the ribbon tab at the top of the Event 
Manager screen.
Result: A blank e-mail window opens.

3. Type an e-mail address in the To ... field, or click the Address Book button at the 
top of the e-mail window to access your Caterease address book.

4. Type a subject for your e-mail in the Subject ... field, or click the down arrow to 
the right of the field to choose a subject from your customizable quick-pick list.

5. Click the Use Merge Document button at the top of the e-mail window.
Result: The Select Document window appears.

6. Click the merge document you want to use as the body of your e-mail.
7. Click OK.

Result: The document you selected is embedded as the body of the e-mail, and all 
merge fields are dynamically merge in.

8. [Optional] Click the Attach button at the top of your e-mail window to attach a 
general computer file, or a Caterease print(s) in .PDF (or other) format.

9. Click Send.

Printing a Document from Account Manager

See Image 4.5 Concept:

In most cases, you are likely going to create merge documents that merge in specific 
event information — for example, the date or guest count of a party. When you print 
these documents from Event Manager, they simply pull information from whichever 
event you happen to be on. However, in Account Manager they behave a little differ-
ently. Often, you might have a customer in Account Manager who has multiple events 
with you. In those cases, which event’s information will appear on your merge docu-
ments when you print them? Well, as you might imagine, Caterease lets you decide.
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Generating Event Merge Documents in Account Manager

1. Open Account Manager and find the customer to whom you would like to send 
your document.

2. Click the Events tab at the bottom of the Account Manager screen.
Result: The tab lists all events — past, present and future — associated with this 
customer.

3. Click any event on the Events tab to select it.
Note: This event’s information will be used to fill in the merge fields in your docu-
ment.

4. Click the Merge Documents button at the bottom of the screen.
Result: The Merge Documents window opens, listing all custom documents you 
have created in your program.

5. Select the title of the document you want to print.
6. Click the Print button at the top right of the Merge Documents window.

Result: A print preview of your chosen document appears.
7. Click the Print button at the top of the Print Preview screen to send this document 

to your printer.

Image 4.5: Printing a Document from Account Manager
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E-mailing Multiple Prints to a Client

1. Hold your [Ctrl] or [Shift] key down to select multiple events on the Events tab.
Note: Holding [Ctrl] lets you select records at random; holding [Shift] and select-
ing two records highlights those records and all in between them.

2. Click the Email button , located on the ribbon tab at the top of the Account 
Manager screen.
Result: A blank e-mail window opens.

3. Type an e-mail address in the To ... field, or click the Address Book button at the 
top of the e-mail window to access your Caterease address book.

4. Type a subject for your e-mail in the Subject ... field, or click the down arrow to 
the right of the field to choose a subject from your customizable quick-pick list.

5. Click the Use Merge Document button at the top of the e-mail window.
Result: The Select Document window appears.

6. Double-click the merge document you want to use as the body of your e-mail.
7. Click Yes at the Replace Text prompt.

Result: The document you selected is embedded as the body of the e-mail, and all 
merge fields are dynamically merge in. Any event-specific merge fields will pull 
data from the last event selected on the Events tab.

8. Click the Attach button at the top of your e-mail window and choose Print.
9. Click the checkbox next to any event print you want to attach.
10. [Optional] Click the down arrow next to Format to change the format of the prints 

to something other than .PDF.
11. Click OK.
12. Click Send.

Result: Your e-mail is sent to your e-mail Outbox, complete with all attached 
prints for each highlighted event.

Remember This:

In this unit, you have learned a few very important concepts about printing and e-mail-
ing merge documents. Here are some things you might want to jot down in the Table 
of Things I Want to Remember on the last page of this book:

• You can easily print a merge document from an event in Event Manager 
(Page 4.1).

• You can make a one-time modification to a merge document as you print it 
(Page 4.2).

• When e-mailing an event print, you can easily use a merge document as the body 
of the outgoing e-mail (Page 4.6).

• You can print a document from Account Manager also, choosing which event’s 
information will merge into the print (Page 4.7).

• You can even attach multiple event prints to a single e-mail document from 
Account Manager (Page 4.9).
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Unit 5: Batch Printing and E-Mailing

Objectives:

Upon completing this unit, you will be able to:

• Print merge documents for multiple events simultaneously.
• E-mail documents for multiple events simultaneously, with event prints attached.

Batch Printing

Concept:

See Image 5.1 When you combine your Marketing Tools package with the query tools in Caterease, 
some incredible things happen. Using the results grids from your various query tools, 
you can generate a batch of custom merge documents for multiple events with one 
mouse click; print a custom contract for every party coming up in the next two weeks; 
send out a collection letter for all of the people who still owe you money for past 
events. With Caterease, it can all happen instantaneously.

Image 5.1: Batch-Printing Documents
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Unit 5:  Batch Printing and E-Mailing
Printing Documents for a Batch of Events

1. Run a Caterease query to get the results grid you want.
2. Click one event on your results screen to select it.
3. Hold your [Shift] or [Ctrl] key down to select multiple records.

Note: Your [Shift] key causes two records you click and all records between them 
to be selected; your [Ctrl] key lets you click multiple, individual records to select 
them.(Select all records in the grid by clicking the first record, holding your 
[Shift] key down and clicking the last record.)

4. Click the Print button.
Result: The Select Desired Print window appears.

5. Click the Documents tab.
6. Select a document by clicking its title.
7. Click the Print button at the bottom right of the form.

Result: One print for each of the selected events will be automatically sent to your 
printer.
Note: Batch prints do not generate a Print Preview; they are sent to your printer 
automatically.

Batch Emailing 

Concept:

See Image 5.2 Imagine sending a batch of e-mails to multiple customers, with a single mouse click, 
complete with event prints attached! Now, imagine you embed one of your custom 
merge documents as the body of the outgoing e-mail, so that each customer receives 
an e-mail message that looks as if it were custom typed just for him. And your fingers 
never have to touch the keyboard!
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Unit 5:  Batch Printing and E-Mailing
E-mailing Documents for a Batch of Events

1. Run a Caterease query to get the results grid you want.
2. Select multiple events by holding down your [Shift] or [Ctrl] key while selecting.

Note: The [Ctrl] key lets you select multiple records; the [Shift] key selects two 
records and all others in between them.

3. Click the Email button  at the top left of the query results screen.
Result: An Untitled Message window appears.
Note: The e-mail address for this outgoing e-mail will default to the Client e-mail 
associated with each selected prospect.

4. [Optional] Click the down arrow to the right of the To... field and choose to send 
the e-mail to the general client e-mail address, or specifically to the booking con-
tact or site contact of the selected events.

5. Type a subject for your e-mail into the Subject... field, or click the down arrow to 
the right of the field to access a custom quick-pick list.

6. Click the Use Merge Document button at the top of the e-mail window.
Result: The Select Document window opens.

Image 5.2: Batch E-mailing
5.3



Unit 5:  Batch Printing and E-Mailing
7. Click the merge document you want to use as the body of your e-mail.
8. Click OK.

Result: The document you selected is embedded as the body of the e-mail.
Note: Merge fields do not merge in at this time.

9. [Optional] Click the Attach button at the top of your e-mail window to attach a 
general computer file, or a Caterease print or prints in .PDF or other format.
Note: Attached files and prints appear in the small pane at the bottom of the 
Email window.

10. When finished, click Send.
Result: The merge fields in the document merge information from each event, and 
each optional attached print is exported.

Remember This:

In this unit, you have learned a few very important concepts about printing and e-mail-
ing merge documents for a batch of events. Here are some things you might want to 
jot down in the Table of Things I Want to Remember on the last page of this book:

• You can print custom merge documents for an entire group of events with a single 
mouse click (Page 5.2).

• You can use your merge documents as the bodies of your outgoing e-mails to mul-
tiple events, with one mouse click (Page 5.3).
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Table of Things I Want to Remember

This table has been provided as a quick reference of things you’ve learned in this book. You can write notes to your-
self, and include the corresponding page in the book that discusses that topic. That way, rather than skimming through 
this entire book to find important information you need, you can simply refer to this table, and then turn to the appro-
priate page when necessary.

Notes Page



Appendix:
Available Merge Fields

Appendix

The following tables list available merge fields in Caterease and their descriptions.  Merge fields can be accessed in 
the Marketing Tools window, and in the various text blocks in Print Designer.

Account Merge Fields

Field Description

Client/Organization Merges in the name of customer holding the currently selected event.

Address Merges in that customer’s address.

Address 2 Merges in that customer’s second address, contained in the Other field (the Other field is dis-
played on screen as a “sub-field” of the Address field, meaning you must click the plus sign to the 
left of the Address field to see Other).

City Merges in that customer’s city.

St/Prov Merges in the state or province that customer is from.

Postal Merges in that customer’s postal/zip code.

City, St/Prov Postal Merges in these three details in this order; meant to eliminate the need to select each field sepa-
rately when they are commonly used in combination (in letters and such).

Telephone Merges in the telephone number of the customer.

Fax Merges in the fax number of the customer.

Reference Merges in the reference that is attached to the customer; Note: This is different from the ref-
erence that is attached to the event; this reference is entered in the account details, and 
indicates how this customer originally heard of your company.

Sales Representative Merges in the sales representative who is attached to this customer; see note under Refer-
ence above.

Sales Rep Telephone Merges in the telehone number associated with the sales representative who is attached to this 
customer; see note under Reference above.

Sales Rep Cellular Merges in the cell phone number associated with the sales representative who is attached to this 
customer; see note under Reference above.

Sales Rep Email Merges in the e-mail address associated with the sales representative who is attached to this 
customer; see note under Reference above.

Category Merges in the category that is attached to this customer; see note under Reference above.

Description Merges in this customer’s description — this is a quick-pick list under your control used for track-
ing your customers.

Email Merges in the customer’s e-mail address; Note: This is the address attached to the customer 
itself, not to a particular contact person.

Cellular Merges in the cell phone number on file for this customer.
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Group Merges in the group of this customer; this is a quickpick list you can customize and use to group 
related customers together.

Account # Merges in the account number automatically assigned to this customer by the program. Note:  
You can establish a unique prefix for these numbers up to three-characters long (through File > 
Setup > Global Settings).

Account ID # Merges in this customer’s Account ID #; this is a field that is under your control.

Loyalty # Merges int the Loyalty # associated with the client

Contact Merge Fields

Field Description

Name Merges in the first name and last name of the primary (first) contact associated with the client.

Title Merges in the title of the primary (first) contact associated with the client; e.g., “Owner”, “General 
Manager”, etc.

Salutation Merges in the salutation of the primary (first) contact associated with the client; e.g., “Tom”, “Mr. 
Smith”, “Mrs. Johnson”, etc. Note:  Salutations are generally created to come at the beginning of a 
merge letter, between the word “Dear” and the comma.

Address Merges in the address of the primary (first) contact associated with the client.

Address 2 Merges in the second address of the primary (first) contact associated with the client.  (“Second 
Address” is contained in the Other field, which is displayed on screen as a “sub-field” of the 
Address field - meaning you must click the plus sign to the left of the Address field to see Other)

City, St/Prov Postal Merges in these three details of the primary (first) contact in this order; meant to eliminate the 
need to select each field separately when they are commonly used in combination (in letters and 
such).

Event Merge Fields

Field Description

Event Date (Long) Merges in the date the event is being held in the format established by your computer’s Regional 
Settings, usually setup as “Saturday, August 30, 2008”.

Event Date (Short) Merges in the date the event is being held in the format established by your computer’s Regional 
Settings, usually setup up as “August 30, 2006”.

Event Date Merges in the date the event is being held, in the format “8/30/2008”

Event Date Formatted Merges in the date of the event and allows you to format it any way you want.

Event Weekday Merges in the full name of the day of the week that the event takes place, in the format “Sunday”, 
“Monday”, etc.

Event Weekday (Abbr) Merges in the first three letters of the day of the week that the event takes place, in the format 
“Sun”, “Mon”, etc.

Event Month Merges in the full month name that the event takes place, in the format “August”, “September”, 
etc.

Account Merge Fields

Field Description
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Event Month (Abbr) Merges in the first three letters of the month that the event takes place, in the format “Aug”, 
“Sep”, etc.

Event Begin Date Merges in the date of the earliest sub-event of the party.

Event End Date Merges in the date of the latest sub-event of the party.

Event Status Merges in the status of the event.

Planned Guests Merges in the planned guest count of the event.

Actual Guests Merges in the actual guest count of the event.

Guaranteed Guests Merges in the guaranteed guest count of the event.

Party Name Merges in the party name of the event.

Booking Contact Merges in the first name and last name of the booking contact of the event.

Booking Contact Title Merges in the title of the booking contact of the event; e.g., “Owner”, “General Manager”, etc.

Booking Contact Salutation Merges in the salutation of the booking contact of the event; e.g., “Tom”, “Mr. Smith”, “Mrs. John-
son”, etc. Note:  Salutations are generally created to come at the beginning of a merge letter, 
between the word “Dear” and the comma.

Booking Contact Telephone Merges in the specific telephone number belonging to the booking contact of the event.  Note:  
This will likely be different from the general phone number belonging to the customer.

Booking Contact Fax Merges in the specific fax number belonging to the booking contact of the event; see note under 
Booking Contact Salutation, above.

Booking Contact Cellular Merges in the specific cell phone number belonging to the booking contact of the event; see 
note under Booking Contact Salutation, above.

Booking Contact Email Merges in the specific e-mail address belonging to the booking contact of the event; see note 
under Booking Contact Salutation, above.

Booking Contact Address Merges in the specific address belonging to the booking contact of the event; see note under 
Booking Contact Salutation, above.

Booking Contact City, St/
Prov, Postal

Merges in these details belonging to the booking contact of the event; see note under Booking 
Contact Salutation, above.

Site Contact Merges in the first name and last name of the site contact of the event.

Site Contact Title Merges in the title of the site contact of the event; e.g., “Owner”, “General Manager”, etc.

Site Contact Salutation Merges in the salutation of the site contact of the event; e.g., “Tom”, “Mr. Smith”, “Mrs. Johnson”, 
etc.  Note:  Salutations are generally created to come at the beginning of a merge letter, 
between the word “Dear” and the comma.

Site Contact Telephone Merges in the specific telephone number belonging to the site contact of the event.  Note:  This 
will likely be different from the general phone number belonging to the customer.

Site Contact Fax Merges in the specific fax number belonging to the site contact of the event; see note under Site 
Contact Salutation, above.

Site Contact Cellular Merges in the specific cell phone number belonging to the site contact of the event; see note 
under Site Contact Salutation, above.

Site Contact Email Merges in the specific email address belonging to the site contact of the event; see note under 
Site Contact Salutation, above.

Sales Representative Merges in the sale representative of the event.

Event Merge Fields (Continued)

Field Description
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Sales Rep Telephone Merges in the specific telephone number belonging to the sales representative of the event.

Sales Rep Cellular Merges in the specific cell phone number belonging to the sales representative of the event.

Sales Rep Email Merges in the specific email address belonging to the sales representative of the event.

Event Category Merges in the category of the event, which is a customizable quick-pick list you can use to track 
your events.  Note:  This field can be renamed to anything you want.

Event Theme Merges in the theme of the event.

Event Pay Method Merges in the pay method of the event, as entered on the Miscellaneous tab in Event Manager.  
Note: This is the general pay method of the event, not the pay method of an individual payment.

Business Type Merges in the business type of the event.

Operation Merges in the operation of the event.

Event Number Merges in the event number automatically assigned to this event by the program. Note:  You can 
establish a unique prefix for these numbers up to three-characters long (through File > Setup > 
Global Settings).

PO Number Merges in the purchase order number for the event if you have entered one on the Miscella-
neous tab in Event Manager.

Folio Number Merges in the folio number for the event if you have entered one on the Miscellaneous tab in 
Event Manager. Note: This field is not usually displayed on your screen by default, but can be 
added by you.

Billing Client If you have entered alternative details in the Optional Billing Information tool in Event Manager, 
this field will merge in that billing client’s name; if you have not, this field will merge in the name 
of the customer holding the event.

Billing Address If you have entered alternative details in the Optional Billing Information tool in Event Manager, 
this field will merge in that billing client’s address; if you have not, this field will merge in the 
address of the customer holding the event.

Billing City If you have entered alternative details in the Optional Billing Information tool in Event Manager, 
this field will merge in that billing client’s city; if you have not, this field will merge in the city of the 
customer holding the event.

Billing St/Prov If you have entered alternative details in the Optional Billing Information tool in Event Manager, 
this field will merge in that billing client’s state or province; if you have not, this field will merge in 
the state or province of the customer holding the event.

Billing Postal If you have entered alternative details in the Optional Billing Information tool in Event Manager, 
this field will merge in that billing client’s postal/zip code; if you have not, this field will merge in 
the postal/zip code of the customer holding the event.

Booked Date Merges in the date on which this event was originally entered into Caterease; this date is auto-
matically assigned by the program, but can be edited by you.

Revised Date Merges in the date on which this event was last revised Caterease; this date is automatically 
assigned by the program, but can be edited by you.

Members Merges in the members guest count of the event. Note: This field can be renamed by you.

Non-Members Merges in the non-members guest count of the event  Note: This field can be renamed by you.

Loyalty # Merges in the loyalty number associated with the event; usually defaults from the client or con-
tact person.

Event Merge Fields (Continued)

Field Description
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Event Notes Merges in all text in the Event Notes text block, complete with rich text formatting.

Event Notes (Unformatted) Merges in all text in the Event Notes text block, without any formatting (so it adopts the format-
ting of the merge document).

Sub-Event Merge Fields*

Field Description

Description Merges in the description of the event’s first sub-event; e.g., “Dinner Buffet”, “Meeting”, “Break-
fast”, etc.

Type Merges in the type of the event’s first sub-event.

Time: Start Merges in the start time of the event’s first sub-event.

Time: End Merges in the end time of the event’s first sub-event.

Time: Delivery Merges in the delivery time of the event’s first sub-event.

Time: Serving Merges in the serving time of the event’s first sub-event. Note: This field can be renamed by you.

Time: Bar Merges in the bar time of the event’s first sub-event. Note: This field can be renamed by you.

Time: Arrival Merges in the arrival time of the event’s first sub-event. Note: This field can be renamed by you.

Time: Departure Merges in the departure time of the event’s first sub-event. Note: This field can be renamed by 
you.

Time: NA These two fields represent two extra time fields that you can make up yourself.  They will each 
merge in the respective time information from the event’s first sub-event.

Time: Setup Merges in the setup time of the event’s first sub-event. Note: This field displays as Hours and 
Minutes, not as a time.

Time: Tear Down Merges in the tear down time of the event’s first sub-event. Note: This field displays as Hours 
and Minutes, not as a time.

Date Merges in the date of the event’s first sub-event.

Room Merges in the name of the room of the event’s first sub-event.

Setup Style Merges in the setup style of the event’s first sub-event.

Site Name Merges in the name of the off-premise site location of the event’s first sub-event.

Site Address Merges in the address of the off-premise site location of the event’s first sub-event.

Site City Merges in the city of the off-premise site location of the event’s first sub-event.

Site St/Prov Merges in the state or province of the off-premise site location of the event’s first sub-event.

Site Postal Merges in the postal/zip code of the off-premise site location of the event’s first sub-event.

Site Telephone Merges in the telephone number of the off-premise site location of the event’s first sub-event.

Site Directions Merges in all text in the Directions text block of the event’s first sub-event, complete with rich text 
formatting.

Site Directions (Unformatted) Merges in all text in the Directions text block of the event’s first sub-event, without any format-
ting (so it adopts the formatting of the merge document).

Event Merge Fields (Continued)

Field Description
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* Note that all sub-event fields only merge in details of an event’s first sub-event. If an event has multiple sub-events, these fields will not reflect 
that. (See Merge Table Options later in this Addendum for techniques to merge in data from multiple sub-events.)

Note: The Staffing Merge Fields listed below are designed to be used to create emails that can be sent in batch to sev-
eral employees from the Staffing Activity Query results screen. Thus, each merge field merges data specific to one 
individual employee and one shift.

Site Website Merges in the website address of the off-premise site location of the event’s first sub-event.

Room Charge Merges in the room charge of the event’s first sub-event.

Delivery Charge Merges in the delivery charge of the event’s first sub-event.

Comments Merges in all text on the Comments tab of the event’s first sub-event, complete with rich text for-
matting.

Comments (Unformatted) Merges in all text on the Comments tab of the event’s first sub-event, without any formatting 
(so it adopts the formatting of the merge document).

Planned Merges in the planned guest count of the event’s first sub-event.

Actual Merges in the actual guest count of the event’s first sub-event.

Guaranteed Merges in the guaranteed guest count of the event’s first sub-event.

Staffing Merge Fields

Field Description

Employee Name Merges in the first and last name of the employee

Start Merges in the start time of the employee

End Merges in the end time of the employee

Position Merges in the position the employee is working

Uniform Merges in the uniform of the employee

Financial Merge Fields

Field Description

Subtotal Merges in the subtotal for the entire event.

Gratuity Merges in the total gratuity for the entire event.

Service Charge Merges in the total service charge for the event.

Tax Merges in the total tax for the event.

Total Merges in the total of the event, including tax and service charge.

Paid Merges in the total amount paid to day for the event.

Balance Merges in the currently outstanding balance for the event.

Sub-Event Merge Fields*

Field Description
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Cost Merges in the total cost (to you) of the event; includes cumulative costs of menu items, as well as 
staffing and any additional cost adjustments you might have made using the Event Costing Sum-
mary tool.

Profit Merges in the total profit for the event.

Discount Merges in the total discount that has been applied to the event using the Apply Discounts tool.

Next Deposit Merges in the amount of the next deposit scheduled for the event. Note: Deposits are scheduled 
using the Deposits Due tool in Event Manager.

Next Deposit Due Date Merges in the due date of the next deposit scheduled for the event (see note above).

Cost Per Guest Merges in the cost per guest for the event that is automatically calculated by dividig the TOTAL of 
the event by the guest count.

Cost Per Guest (Subtotal) Merges in the cost per guest automatically calculated by dividing the SUBTOTAL by the guest 
count.

Cancel Charge Merges in the cancellation charge for the event, as entered into the Miscellaneous tab in Event 
Manager.

Cancel Date Merges in the date on which this event was cancelled; this date is automatically assigned by the 
program, but can be changed by you.

Room Charge Merges in the amount entered in the Room Charge field on the Rooms tab of the Sub-Event win-
dow.

Delivery Charge Merges in the amount entered in the Delivery Charge field on the Delivery tab of the Sub-Event 
window.

Food Subtotal Merges in the sum total of all menu items with a type of “Food” ordered for the entire event.

Beverage Subtotal Merges in the sum total of all menu items with a type of “Beverage” ordered for the entire event.

Liquor Subtotal Merges in the sum total of all menu items with a type of “Liquor” ordered for the entire event.

Equipment Subtotal Merges in the sum total of all menu items with a type of “Liquor” ordered for the entire event.

Labor Subtotal Merges in the sum total of all menu items with a type of “Labor” ordered for the entire event.

Room Subtotal Merges in the sum total of all menu items with a type of “Room” ordered for the entire event.

Other Subtotal Merges in the sum total of all menu items with a type of “Other” ordered for the entire event.

Taxes: First Merges in the total First Tax (from the first tax column) for the event.  Note:  Many companies will 
only use this first column, and thus do not need this breakdown.  Those companies can simply 
use the “Tax” merge field, above.

Taxes: Second Merges in the total Second Tax (from the second tax column) for the event.  See note above.

Taxes: Third Merges in the total Third Tax (from the third tax column) for the event.  See note above.

Proposal Merge Fields

Field Description

Party Name Merges in the Party Name of the proposal.

Sales Rep Merges in the sales representative of the proposal.

Financial Merge Fields (Continued)

Field Description
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Sales Rep Telephone Merges in the specific telephone number belonging to the sales representative of the proposal.

Sales Rep Cellular Merges in the specific cell phone number belonging to the sales representative of the proposal.

Sales Rep Email Merges in the specific email address belonging to the sales representative of the proposal.

Theme Merges in the theme of the proposal.

Reference Merges in the reference of the proposal.

Booking Contact Merges in the first name and last name of the booking contact of the proposal.

Booking Contact Title Merges in the title of the booking contact of the proposal; e.g., “Owner”, “General Manager”, etc.

Booking Contact Salutation Merges in the salutation of the booking contact of the proposal; e.g., “Tom”, “Mr. Smith”, “Mrs. 
Johnson”, etc. Note: Salutations are generally created to come at the beginning of a merge let-
ter, between the word “Dear” and the comma.

Planned Guests Merges in the planned guest count of the proposal.

Actual Guests Merges in the actual guest count of the proposal.

Date Merges in the date on which the proposed event would take place.

Start Time Merges in the start time of the proposal.

End Time Merges in the end time of the proposal.

Subtotal Merges in the subtotal of the proposal.

Gratuity Merges in the gratuity of the proposal.

Service Charge Merges in the service charge of the proposal.

Tax Merges in the tax of the proposal.

Total Merges in the total of the proposal.

Cost Per Guest Merges in the cost per guest for the proposal that is automatically calculated by dividig the 
TOTAL by the guest count.

Cost Per Guest (Subtotal) Merges in the cost per guest automatically calculated by dividing the SUBTOTAL by the guest 
count.

Guestrooms Manager Fields

Field Description

Arrival Date Merges in the arrival date of the group rooms booking.

Departure Date Merges in the departure date of the group rooms booking.

Group Name Merges in the group name of the group rooms booking.

Status Merges in the status of the group rooms booking.

Proposal Merge Fields

Field Description
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.

Booking Contact Merges in the first name and last name of the booking contact of the group rooms booking.

Booking Contact Title Merges in the title of the booking contact of the group rooms booking; e.g., “Owner”, “General 
Manager”, etc.

Booking Contact Salutation Merges in the salutation of the booking contact of the group rooms booking; e.g., “Tom”, “Mr. 
Smith”, “Mrs. Johnson”, etc.  Note:  Salutations are generally created to come at the beginning of 
a merge letter, between the word “Dear” and the comma.

Site Contact Merges in the first name and last name of the site contact of the group rooms booking.

Site Contact Title Merges in the title of the site contact of the group rooms booking; e.g., “Owner”, “General Man-
ager”, etc.

Site Contact Salutation Merges in the salutation of the site contact of the group rooms booking; e.g., “Tom”, “Mr. Smith”, 
“Mrs. Johnson”, etc.  Note:  Salutations are generally created to come at the beginning of a 
merge letter, between the word “Dear” and the comma.

Sales Rep Merges in the sales representative of the group rooms booking.

Method of Reservation Merges in the method of reservation of the group rooms booking.

Reservation Cut-Off Merges in the reservation cut-off date of the group rooms booking.

Pay Method Merges in the payment method of the group rooms booking.

Contract Return Date Merges in the contract return date of the group rooms booking.

Log # Merges in the log # (automatically assigned by the program) of the group rooms booking.

Folio # Merges in the folio # of the group rooms booking.

Room Count Merges in the total number of rooms blocked for the group rooms booking.

Tax Merges in the total taxes of the group rooms booking.

Total Merges in the total of the group rooms booking.

Next Deposit Merges in the amount of the next deposit due for the group rooms booking.

Next Deposit Due Date Merges in the due date of the next deposit due for the group rooms booking.

User Defined Merge Fields

Field Description

Account User Defined Fields Lists all custom fields you may have created for your accounts (customers)

Event User Defined Fields Lists all custom fields you may have created for your events.

Sub-Event User Defined 
Fields

Lists all custom fields you may have created for your sub-events (meals)

Site User Defined Fields Lists all custom fields you may have created for your site locations

Proposal User Defined Fields Lists all custom fields you may have created for your proposals in Prospect Manager

Guestrooms User Defined 
Fields

Lists all custom fields you may have created for your group rooms bookings

Guestrooms Manager Fields

Field Description
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Note: The special “Merge Table” options listed below allow you to merge multiple details (menu items, employees, 
payments, etc.)into a custom print - thus creating virtually any custom event print layout. You can even use “nested 
tables” (a merge table within another table) to display details on the left or right side of a document. (Notice that 
some merge tables are specifically designed to be printed from managers other than Event Manager.) 

Special Merge Fields

Field Description

Current Date (Long) Merges in the current date including day, in the format “Saturday, August 30, 2008”.

Current Date Merges in the current date, in the format “8/30/2008”.

Current Time Merges in the current time, in the format “05:35 pm”.

Tax Exempt Merges in the words “Tax Exempt” if the event is tax exempt; if not, remains blank.

Tax Exempt Number Merges in the word “Number:” followed by the event’s tax exempt number, if one exists; if not, 
remains blank.

Merge Table Options

Merge Table Description

Food/Service Items Designed for prints from Event Manager. Displays event menu item details either altogether, 
grouped by sub-event or filtered to only show items based on chosen item “Types” or “Catego-
ries”.  Options also exist to add a summary footer to total just the items included in the table, as 
well as to suppress “Hidden” items or items with no quantities associated with them.

Proposal Items Designed for prints from Prospect Manager. Displays menu items from a proposal in Prospect 
Manager, either altogether or filtered to only show items based on chosen item “Types” or “Cate-
gories”.  Options also exist to add a summary footer to total just the items included in the table, 
as well as to suppress “Hidden” items or items with no quantities associated with them.

Menu Items Designed for prints from Menu Manager. Displays menu items listed on various default menus, 
either altogether (all items from all menus) or filtered to only show items from a specific menu or 
with chosen item “Types” or “Categories”

Payments Made Designed for prints from Event Manager. Displays details of payments made to an event, either 
altogether or filtered based on “Payment Method”.

Deposits Due Designed for prints from Event Manager.  Displays details of deposits due for an event, either 
altogether or filtered based on whether or not they have been paid.

Shifts Designed for prints from Event Manager.  Displays details of shifts (not specific employees) for 
an event, either altogether, grouped by sub-event or filtered based on “Position” or “Category”.  
The options also exist to add a summary footer to total just the shifts included in the table.

Staffing Designed for prints from Event Manager. Displays details of specific employees scheduled to 
work an event, either altogether, grouped by sub-event or filtered based on “Position”, “Cate-
gory”, or whether or not they’ve confirmed their shift.

Sub-Events Designed for prints from Event Manager. Displays details of sub-events for an event, either alto-
gether or filtered based on sub-event “Description” or “Type”.

Financial Summaries:
Food/Service Items

Designed for prints from Event Manager. Displays the group totals of all menu items in an event 
with a certain “Type(s)” or “Category(ies)”, including the option to add a summary footer to total 
all groups listed in the table and to suppress any group with a total of zero.
Appendix



Financial Summaries:
Proposal Items

Designed for prints from Prospect Manager.  Displays the group totals of all menu items in a pro-
posal with a certain “Type(s)” or “Category(ies)”, including the option to add a summary footer to 
total all groups listed in the table and to suppress any group with a total of zero.

Financial Summaries:
Summary Totals

Designed for prints from Event Manager. Displays financial summary totals (subtotal, tax, service 
charge, total amount paid, total outstanding balance, etc.) for an event, including the option to 
suppress any total with a value of zero.

Merge Table Options

Merge Table Description
Appendix
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	Unit 1: Creating Custom Merge Documents
	Objectives:

	Upon completing this unit, you will be able to:
	• Access the Marketing Tools package.
	• Add a new document.
	• Create document categories using “child records.”
	• Insert images into a document.
	• Add merge fields to a document.
	• Format text in a document.

	Using the Marketing Tools Package
	Accessing the Marketing Tools Package
	See Image 1.1
	1. Click the Setup sidebar group on the left-hand side of your Caterease screen.
	2. Click the Marketing Tools button. Note: As an option, you can also select Administration > Prints > Marketing Tools from the drop-down menus at the top of the screen.

	Adding a New Merge Document
	1. Access Marketing Tools via one of the options listed above.
	2. Click the Add Record button , located on your main Caterease toolbar at the top of the screen. Result: A confirmation message appears.
	3. Click Yes to confirm your choice. Result: A new, blank field is added to your list, with your cursor ready to type a new title.
	4. Type a name for your new document, and press your [Enter] key. Result: Your new document name is saved.
	5. Click into the main text block of the Marketing Tools form and type the body of your document as desired. Note: See the following sections for information on inserting merge fields, images, and tables into your merge document.
	6. [Optional] Format your document's text using the Basic Text Editing option located on your main Caterease screen (see the following sections).
	Adding a Document as a Child Record (Sub-Record)
	1. From Marketing Tools, click the Add Record button , located on your main Caterease toolbar at the top of the screen. Result: A confirmation message appears.
	2. Click Yes to confirm your choice. Note: This adds a new blank document title, as described in Step 1 under Adding a New Document, above. In this section, however, we are going to use this new title as the title of the group or category of document...
	3. Type a name for your category or group of documents, and press your [Enter] key. Result: Your new category name is saved.
	4. Click the Add Child Record button , also located at the top of your screen. Result: A confirmation message appears.
	5. Click Yes to confirm your choice. Result: A new document title is added as a sub-record of the title you added in Step 1, above.
	6. Type a name for your new document, and press your [Enter] key. Result: Your new document name is saved.
	7. Click into the main text block of the Marketing Tools form and type the body of your document as desired. Note: See the following sections for information about inserting merge fields, images, and tables into your merge document.
	8. [Optional] Format your document's text using the Basic Text Editing option located on your main Caterease screen (see the following sections).


	Inserting Images into a Document
	1. Click in the document to place your cursor where you want the image to be inserted.
	2. Click the Insert button , located at the top of the Marketing Tools form, and select Image. Alternatively, you may right-click anywhere in the document and select Insert Image. Result: A window opens, allowing you to browse to an image.
	3. Click the down arrow next to File name and browse your way to your desired image.
	4. Double-click the image to select it. Note: As a default, the image is inserted as a “Character.” (See Changing the Attach Mode of an Image, below.) This means that it will move as other text moves, and you can use the Format toolbar to align i...
	5. Click Open. Result: The selected image is placed in the document wherever your cursor is blinking.
	6. Format your document’s text and image using the Basic Text Editing option at the top left-hand side of your Caterease screen.
	Changing the Attach Mode of an Image
	See Image 1.5
	1. Right-click an image in your document. Result: A pop-up menu appears.
	2. Select Attach Mode.
	3. Choose from the following options:


	Adding Merge Fields to a Document
	See Image 1.6
	1. Click the Insert Merge Fields button , located at the top right-hand side of the Marketing Tools form you are working on. Result: The Fields Explorer window opens. Note: If you plan to insert several merge fields, you may want to leave this window...
	2. Click the plus sign to the left of a particular category of fields, e.g., Event Fields, Financial Fields, etc., to expand the fields. Result: The selected category opens to show all related fields. Note: As an option, click the Full Expand button ...
	3. Select a merge field, and insert in one of the following ways:
	Using Advanced Merge Field Options
	Using Formatted Date Fields (See Table 1.1)
	1. Click inside the document to place your cursor where you want the merge field to be inserted.
	2. Click the Insert Merge Fields button , located at the top right-hand side of the Marketing Tools form you are working on.
	3. Click the plus sign to the left of Event Fields (for Event Date Formatted or Booked Date Formatted) or Special Fields (for Current Date Formatted).
	4. Select the desired merge field and insert it in one of the following ways:
	5. Format the date field by editing the “mmmm,” “d,” “y,” and number within the brackets, using the options listed in the table below.
	Table 1.1: Formatted Date Fields


	Formatting Text (See Table 1.2)
	1. Within a document in the Marketing Tools, highlight any text you wish to format by holding your left mouse button down and dragging over the text.
	2. Access the Basic Text Editing toolbar at the top of your Caterease screen.
	3. In the Font window, choose a different font, font style, size, color, or effect for your text.
	Table 1.2: Format Toolbar Buttons

	Remember This:
	Unit 2: Advanced Features for Custom Merge Documents
	Objectives:


	Upon completing this unit, you will be able to:
	• Create headers and footers.
	• Insert a table into a merge document.
	• Color row, column, or text background.
	• Insert a hyperlink.
	• Insert a page break.
	• Add or delete columns or rows to a table.
	• Adjust the page margins of a document.
	• Create a custom envelope.

	Creating Headers and Footers
	1. From Marketing Tools, click the title of the document you want to add headers or footers to.
	2. Click the Tools button, located in the Extended Text Editing group on the Home ribbon tab at the top of the screen.
	3. Click Headers & Footers Result: The Manage Header & Footer window opens.
	4. Choose Add Header or Add Footer.
	5. From the drop-down list which displays, select which pages should include the new header/footer. Result: The header/footer is added to the document, and your cursor is placed in it. Note: If adding a header/footer that will not appear on the curre...
	6. Type the header/footer text and then format as desired. Note: Insert images, merge fields, etc., into headers and footers as desired, using the steps described in the previous unit.
	7. [Optional] Add additional headers or footers as desired by repeating steps 4-6. Note: Switch from one header/footer to another by clicking on it in the Manage Header & Footer window. Move to the body of the document by clicking Go To Body.
	8. [Optional] Click the Options button and choose Save Text to save this custom header/footer for use in another merge document. Note: To add a previously saved header/footer into a document, add a header/ footer as described above and then click Opt...
	9. When finishing editing headers/footers, click Close.

	Inserting a Table into a Document
	Creating a Table
	1. Click in the document where you would like the table to be inserted.
	2. Click the Create Table button, located under Tables, on the right-hand side of the Marketing Tools window, in the Extended Text Editing section. Result: The Insert Table window opens.
	3. Create a table by setting the following options:
	4. When finished, click OK. Result: The table is inserted at the current position of your mouse pointer. Note: As an alternative, you can click the Create Table Tool button, move your mouse to indicate the number of columns and rows you want in your ...

	Modifying a Table (See Table 2.1)
	1. Click your cursor in the cell of the table at the point you want to make a modification (or highlight multiple cells).
	2. Select from the options described below, which are available on the toolbar at the right of the Marketing Tools form.
	Table 2.1: Table Modifications

	Deleting a Table
	1. Click anywhere in a table to place your cursor in that table.
	2. Hold your left mouse button down and drag over the entire table to select it.
	3. Press the [Delete] key on your keyboard. Result: The highlighted table is deleted, without confirmation.You may also delete a table by clicking the Tables button and clicking Delete. Note: If you accidentally delete a table, you can click the Canc...


	Coloring Row, Column, or Text Background
	Adding Color to a Table’s Row, Column, or Cell
	1. Click inside the table’s cell or highlight an entire row or column.
	2. Click the Shading button , located in the Extended Text Editing group on the Home ribbon tab at the top of the screen.
	3. Choose a background color or optionally click Custom to define a custom color. Result: The background color of the selected cell, row, or column, will be changed. Note: The background color of any text in these cells will remain white, and must be...

	Adding Background Color to Text
	1. Highlight the desired text in a merge document.
	2. Click the Text Highlight Color button , located in the Extended Text Editing group on the Home ribbon tab at the top of the screen.
	3. Choose a background color or optionally click Custom to define a custom color. Result: The background color of the selected text will be changed.


	Inserting Merge Formulas
	See Image 2.3
	Setting up the Merge Formula Default
	See Image 2.3
	1. Click the Tools button at the top right of the Marketing Tools window and choose Merge Formulas Setup. Result: The Marketing Tools Merge Formula Setup window opens.
	2. Along the Merge Formulas (left-hand) pane of the window, click the Add Formula button . Result: The Edit Formula window opens.
	3. Type a name for the formula into the Name field.
	4. Click the Edit Default Value button . Result: The Formula Default Value text block opens.
	5. Enter a default value for this formula, formatting text and inserting merge fields as described in the previous unit. Note: This is the default text that will appear whenever you insert this formula, unless certain conditions you set (see below) a...

	Establishing Conditions for a Formula
	See Image 2.4
	1. Click the Tools button at the top right of the Marketing Tools window and choose Merge Formulas Setup. Result: The Marketing Tools Merge Formula Setup window opens.
	2. In the Merge Formulas (left-hand) pane, select a formula to establish conditions for.
	3. Along the Optional Evaluations (right-hand) pane, click the Add Evaluation button . Result: The Edit Evaluation window opens.
	4. In the first drop-down on the Edit Evaluation window, set a condition for the merge formula. Note: For example, you can set a condition that different text should appear if printing for an event that has a certain theme, a date that falls within a...
	5. Use the two drop-down lists to finish the condition. For example, if you chose Event-Theme from the first drop-down list, you might choose Equals and then select a particular theme in the second drop-down.
	6. Click the View/Edit Evaluation Results button . Result: The Formula Results Value text block opens.
	7. Enter a default value for this formula, formatting text and inserting merge fields as described in the previous unit.
	8. Click the X at the top right-hand corner of the text block to close the window, and click OK to close the Edit Evaluation window.
	9. [Optional] Drag this new condition up or down in the list on the Optional Evaluations (right-hand) pane of the window to establish a priority of conditions. Note: Evaluations will be performed in the order in which they are listed. For example, if...
	10. Repeat steps 3-9 to add more conditions to the list as desired.
	11. When finished, click the X at the top right-hand side of the Merge Formulas Setup window to close it.

	Inserting Merge Formulas into a Document
	1. Click in the document to place your cursor where you want the merge formula to be inserted.
	2. Click the Insert Merge Formulas button , located at the top right of the Marketing Tools window.
	3. Select a merge formula and insert it in one of the following ways:


	Inserting a Hyperlink
	See Image 2.5
	1. Click in your document where you would like the hyperlink to appear.
	2. Click the Insert button , located in the Home ribbon tab at the top of your screen, in Extended Text Editing.
	3. Choose Hyperlink. Note: Alternatively, you may right-click anywhere in the document and select Insert > Hyperlink. Result: The Insert Hyperlink pop-up window opens.
	4. In the first field of the pop-up window, enter the web address (URL) for the hyperlink. Note: If you previously copied the address from your web browser, that address will default for you.
	5. In the second field, enter the text that will serve as the hyperlink in the document, or select the Image option to select an image for use as the hyperlink.
	6. When finished, click OK. Note: If creating a text hyperlink, your custom hyperlink will reside in the document. If using an image as a hyperlink, a browser window will open, where you can select the image to be used (and then click Open).

	Inserting a Page Break
	Inserting the Page Break
	1. Click in your document where you would like the page break to appear.
	2. Click the Insert button , located in the Home ribbon tab at the top of your screen, in Extended Text Editing.
	3. Choose Page Break. Note: Alternatively, you may right-click anywhere in the document and select Insert > Page Break. Result: The document separates, and all information below your insertion point appears on the next page.


	Adjusting Page Margins and Other Setup Options
	See Image 2.6
	Accessing the Page Layout Form
	1. Click the Tools button at the top of the Marketing Tools window, under Extended Text Editing.
	2. Choose Page Setup.

	Choosing a Paper Size
	1. Click the down arrow under Paper Size on the Page Layout form.
	2. Select the desired paper size (ex: “Legal,” “Envelope,” etc.).
	3. When finished, click OK.

	Adjusting the Page Margins in a Document
	1. Use the up or down arrows next to the Top, Bottom, Left and Right field in the Page Layout form to adjust those page margins accordingly (or simply type into the fields).
	2. When finished, click OK.

	Switching between Portrait and Landscape Orientation
	1. In the Orientation section of the Page Layout form, click the radio button next to Portrait or Landscape to select a style.
	2. When finished, click OK.


	Setting a New Paper Color
	1. In the left pane of the Marketing Tools window, select the title of the document you want to change the color of.
	2. Click the Tools button in the Home ribbon tab at the top of the screen and place your cursor over Paper Color. Result: A popup color palette opens.
	3. Click on the desired color within the color palette or click the Custom button to select a custom color. Note: Click the Clear button at the top of the popup window if you would like to clear your color selection.

	Creating a Custom Merge Envelope
	See Image 2.7
	1. With your Marketing Tools window open, click the Add Record button , located on your main Caterease toolbar at the top of the screen. Result: A confirmation prompt appears.
	2. Click Yes to confirm your choice. Result: A new blank document is added to your list, with your cursor ready to type a new title.
	3. Type a name for your new envelope and press your [Enter] key. Result: Your new envelope name is saved.
	4. Click the Tools button at the top of the Marketing Tools window.
	5. Choose Page Setup.
	6. Click the down arrow under Paper Size on the Page Layout form.
	7. Select the desired envelope size (ex: “Envelope #10,” “Envelope Monarch,” etc.).
	8. [Optional] Change the margins of your envelope by typing in the fields listed under Margins, or use the up-and-down arrow keys to adjust.
	9. Click the radio button labeled Landscape under Orientation. Result: The envelope orientation flips to “Landscape,” or sideways.
	10. When finished, click OK.
	11. Click in the main text block of the Marketing Tools form and type as desired to create your new envelope. Note: See previous unit for information on inserting merge fields into your envelope.
	12. [Optional] Format your envelope’s text using the Format toolbar at the top of your Caterease screen (see previous unit for more information).

	Remember This:
	Unit 3: Creating Advanced Event Prints
	Objectives:


	Upon completing this unit, you will be able to:
	• Insert dynamic merge tables into a document to include such details as menu items, staffing, payments, deposits, etc.
	• Modify a merge table.
	• List merge table options within a document.
	• Use nested tables to place details in the print.
	Inserting a Merge Table into a Document
	Inserting a Merge Table (See Image 3.1)
	1. Click in the document where you would like the merge table to be inserted.
	2. Click the Insert Merge Table button , located at the top right of the Marketing Tools window. Result: A list of merge table options appears.
	3. Select a merge table from the following options:
	4. Select the specific details to be included in the merge table by clicking checkboxes under the Select Fields section (left-hand side of the merge table window). Note: You can drag and drop fields up and down in this Select Fields panel to repositi...

	Establishing Display Options (See Image 3.2)
	1. In the Display Options section of the window (top right-hand pane), choose from among the following options:

	Establishing Filter Options (See Image 3.2)
	1. In the Filter Options section of the window (bottom right-hand pane), set the appropriate filters based on the type of merge table you are inserting. Note: You can add multiple merge tables in a document to separate items based on type, category, ...
	2. When finished, click OK.


	Modifying a Merge Table
	Table 3.1: Filter Options
	Inserting Additional Fields
	1. Click inside the merge table where you want a new field to appear. Note: You can add new columns or rows for new fields as discussed in the previous unit.
	2. Click your right mouse button.
	3. Choose Merge Tables > Available Merge Fields. Result: A list appears of available fields for the specific merge table you are working with.
	4. Select a field from the list.

	Displaying the Table Filter
	1. Click in a specific merge table.
	2. Click your right mouse button.
	3. Choose Merge Tables > Display Filter. Result: A pop-up message appears, identifying the filter of that particular table.
	4. Click OK to close the pop-up message.

	Editing the Table Filter
	1. Click into a specific merge table.
	2. Click your right mouse button.
	3. Choose Merge Tables > Edit Filter. Result: A pop-up window appears, allowing you to edit the existing filter for the table.
	4. Edit the filter as desired and click OK.


	Nesting Merge Tables
	See Image 3.4
	Creating the Original Table
	1. Click the Create Table button , located under Tables, in the Extended Text Editing section of the Marketing Tools screen.
	2. Choose the desired number of columns and rows for the table. Note: This table is establishing the layout of your print. For example, if you want to separate menu items into two columns on the left and right side of the print, you would want to cre...
	3. Set other options, such as whether or not to show borders in the table, as described previously.

	Inserting “Nested” Tables (See Image 3.4)
	1. Click into the column or row of your original table where you would like to place your nested merge table.
	2. Click the Insert Merge Table button .
	3. Select the specific type of merge table you want to insert.
	4. Click Yes at the prompt to confirm you want to create a nested merge table.
	5. Format the merge table options as described earlier in this unit. Result: Your custom merge table is inserted specifically in the row or column you have chosen - e.g., only on the left half of the page, etc. Note: Be sure the merge table option In...


	Remember This:
	Unit 4: Printing and Emailing Merge Documents
	Objectives:


	Upon completing this unit, you will be able to:
	• Print a merge document for an individual event.
	• Make a one-time only change to a document prior to printing.
	• E-mail a merge document.
	• Use a merge document as the body of an outgoing e-mail message.
	• Print documents for a batch of events at one time.
	• Print a merge document from Account Manager.
	Printing a Document for an Event
	See Image 4.1
	1. Open your Event Manager on the specific event from which you want to print a documents
	2. Click the Merge Documents button , located at the bottom of your Caterease screen. Result: The Merge Documents window opens, listing all custom documents you have created in your program.
	3. Select the title of the document you want to print.
	4. Click the Print button at the top right of the Merge Documents window. Result: A Print Preview of your chosen document opens.
	5. Click the Print button at the top of the Print Preview screen to send this document to your printer.


	Making a One-Time Modification to a Document
	See Image 4.2
	1. Open your Event Manager on the specific event from which you want to print a document.
	2. Click the Merge Documents button at the bottom of your Caterease screen. Result: The Merge Documents window opens.
	3. Select the title of the document you want to print.
	4. Click the Modify button at the top right of the Merge Documents window. Result: Your document merges in information from the current event, and is displayed in an editor window.
	5. Click anywhere in the editor window and type or edit as desired.
	6. When finished, click the Prints button at the top left of the window. Result: Your document, with its modifications, is displayed in a Print Preview screen.
	7. Click the Print button at the top of the Print Preview screen to send this document to your printer.


	Using the Floating Print Selection Tool
	See Image 4.3
	1. Open your Event Manager on the specific event from which you want to print a document.
	2. Click the top half of the Prints button, located on the Home ribbon tab at the top of your Caterease screen. Result: The Select Desired Prints window opens.
	3. Click the Prints tab on the left-hand side of the window. Note: All prints created in your Marketing Tools package are stored on the Prints tab.
	4. Click the title of the print you want to print.
	5. [Optional] Click the Multiple button at the top of the window and move titles to the right-hand pane of the tool (using the black right-arrow) to generate multiple prints at once. Note: As an alternative, you can double-click print titles with the...
	6. Click the Print button at the bottom of the window to generate the print(s). Note: Alternatively, you can double-click the title of a print to generate it.
	7. [Optional] For maximum flexibility, leave this floating tool open, with your favorite prints selected, as you move from event to event.


	Emailing a Merge Document
	See Image 4.4
	1. Open your Event Manager on the specific event from which you want to print a document.
	2. Click the Merge Documents button at the bottom of your Caterease screen.
	3. Select the title of the document you want to e-mail.
	4. Click the Email button at the top right of the Merge Documents window. Result: Your document merges in information from the current event, and is displayed in an e-mail window.
	5. Type an e-mail address in the To ... field, or click the Address Book button at the top of the e-mail window to access your Caterease address book.
	6. Type a subject for your e-mail in the Subject ... field, or click the down arrow to the right of the field to choose a subject from your customizable quick-pick list.
	7. [Optional] Click the Attach button at the top of your e-mail window to attach a general computer file or a Caterease print or prints in.PDF or other format.
	8. When finished, click Send. Result: The e-mail is sent, using the e-mail settings established in the program (Administration ribbon tab > Settings > Email Settings), and a message appears, offering to close the window. Note: Before closing the e-ma...


	Using a Merge Document as the Body of an E-mail
	1. Access the e-mail window from a Print Preview screen, as described above.
	2. Click the Use Merge Document button from the menu at the top of the window. Result: The Select Document window opens.
	3. Double-click the merge document you want to use as the body of your e-mail.
	4. Click OK. Result: The document you selected is embedded as the body of the e-mail, and all merge fields are dynamically merged in. Note: If content already existed in the body of the e-mail (including default signature), you will be asked if you w...
	Copying Sent E-mails into Contact Manager
	1. Click the Contact History ribbon tab at the top of the e-mail window.
	2. [Optional] Edit the Comment on the Contact History ribbon tab as desired. Note: This is the content of the history note that will be added to your Contact Manager. It defaults to the words “Sent Email” and then the subject of the current email.
	3. Click the Save button, located at the top left-hand side of the Contact History tab. Result: An information window displays, indicating that a contact history note has been recorded for this customer, automatically stamped with the current date an...
	4. Click OK to close the information window.
	5. [Optional] It is not necessary to click the Save Email Content button , located next to the Auto Save in Contact Manager button and selecting your options; this option is generally set to occur automatically as a default. (See note in Step 3, above.)
	6. Click OK to close the information window.

	Generating E-mails from the Event Manager Toolbar
	1. Open the event in Event Manager for which you want to e-mail the print.
	2. Click the E-mail button , located on the ribbon tab at the top of the Event Manager screen. Result: A blank e-mail window opens.
	3. Type an e-mail address in the To ... field, or click the Address Book button at the top of the e-mail window to access your Caterease address book.
	4. Type a subject for your e-mail in the Subject ... field, or click the down arrow to the right of the field to choose a subject from your customizable quick-pick list.
	5. Click the Use Merge Document button at the top of the e-mail window. Result: The Select Document window appears.
	6. Click the merge document you want to use as the body of your e-mail.
	7. Click OK. Result: The document you selected is embedded as the body of the e-mail, and all merge fields are dynamically merge in.
	8. [Optional] Click the Attach button at the top of your e-mail window to attach a general computer file, or a Caterease print(s) in .PDF (or other) format.
	9. Click Send.


	Printing a Document from Account Manager
	See Image 4.5
	Generating Event Merge Documents in Account Manager
	1. Open Account Manager and find the customer to whom you would like to send your document.
	2. Click the Events tab at the bottom of the Account Manager screen. Result: The tab lists all events — past, present and future — associated with this customer.
	3. Click any event on the Events tab to select it. Note: This event’s information will be used to fill in the merge fields in your document.
	4. Click the Merge Documents button at the bottom of the screen. Result: The Merge Documents window opens, listing all custom documents you have created in your program.
	5. Select the title of the document you want to print.
	6. Click the Print button at the top right of the Merge Documents window. Result: A print preview of your chosen document appears.
	7. Click the Print button at the top of the Print Preview screen to send this document to your printer.

	E-mailing Multiple Prints to a Client
	1. Hold your [Ctrl] or [Shift] key down to select multiple events on the Events tab. Note: Holding [Ctrl] lets you select records at random; holding [Shift] and selecting two records highlights those records and all in between them.
	2. Click the Email button , located on the ribbon tab at the top of the Account Manager screen. Result: A blank e-mail window opens.
	3. Type an e-mail address in the To ... field, or click the Address Book button at the top of the e-mail window to access your Caterease address book.
	4. Type a subject for your e-mail in the Subject ... field, or click the down arrow to the right of the field to choose a subject from your customizable quick-pick list.
	5. Click the Use Merge Document button at the top of the e-mail window. Result: The Select Document window appears.
	6. Double-click the merge document you want to use as the body of your e-mail.
	7. Click Yes at the Replace Text prompt. Result: The document you selected is embedded as the body of the e-mail, and all merge fields are dynamically merge in. Any event-specific merge fields will pull data from the last event selected on the Events...
	8. Click the Attach button at the top of your e-mail window and choose Print.
	9. Click the checkbox next to any event print you want to attach.
	10. [Optional] Click the down arrow next to Format to change the format of the prints to something other than .PDF.
	11. Click OK.
	12. Click Send. Result: Your e-mail is sent to your e-mail Outbox, complete with all attached prints for each highlighted event.


	Remember This:
	Unit 5: Batch Printing and E-Mailing
	Objectives:


	Upon completing this unit, you will be able to:
	• Print merge documents for multiple events simultaneously.
	• E-mail documents for multiple events simultaneously, with event prints attached.
	Batch Printing
	Concept:
	See Image 5.1

	Printing Documents for a Batch of Events
	1. Run a Caterease query to get the results grid you want.
	2. Click one event on your results screen to select it.
	3. Hold your [Shift] or [Ctrl] key down to select multiple records. Note: Your [Shift] key causes two records you click and all records between them to be selected; your [Ctrl] key lets you click multiple, individual records to select them.(Select al...
	4. Click the Print button. Result: The Select Desired Print window appears.
	5. Click the Documents tab.
	6. Select a document by clicking its title.
	7. Click the Print button at the bottom right of the form. Result: One print for each of the selected events will be automatically sent to your printer. Note: Batch prints do not generate a Print Preview; they are sent to your printer automatically.


	Batch Emailing
	See Image 5.2
	E-mailing Documents for a Batch of Events
	1. Run a Caterease query to get the results grid you want.
	2. Select multiple events by holding down your [Shift] or [Ctrl] key while selecting. Note: The [Ctrl] key lets you select multiple records; the [Shift] key selects two records and all others in between them.
	3. Click the Email button at the top left of the query results screen. Result: An Untitled Message window appears. Note: The e-mail address for this outgoing e-mail will default to the Client e-mail associated with each selected prospect.
	4. [Optional] Click the down arrow to the right of the To... field and choose to send the e-mail to the general client e-mail address, or specifically to the booking contact or site contact of the selected events.
	5. Type a subject for your e-mail into the Subject... field, or click the down arrow to the right of the field to access a custom quick-pick list.
	6. Click the Use Merge Document button at the top of the e-mail window. Result: The Select Document window opens.
	7. Click the merge document you want to use as the body of your e-mail.
	8. Click OK. Result: The document you selected is embedded as the body of the e-mail. Note: Merge fields do not merge in at this time.
	9. [Optional] Click the Attach button at the top of your e-mail window to attach a general computer file, or a Caterease print or prints in .PDF or other format. Note: Attached files and prints appear in the small pane at the bottom of the Email window.
	10. When finished, click Send. Result: The merge fields in the document merge information from each event, and each optional attached print is exported.


	Remember This:
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